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Part 1: Introduction

1. About this manual
The Olink® NPX Signature User Manual provides you with the instructions needed for processing the raw data and 
performing quality control on the data from Olink® Target 48 panels with the Olink® NPX Signature software. 

This manual contains step-by-step instructions for analysis in Olink NPX Signature and troubleshooting.

1.1 Intended use
Olink® NPX Signature is a data analysis software that is designed for use with the qPCR-based kits from Olink, including 
Olink® Target 48, Olink® Target 96, Olink® Focus as well as for Olink® Flex panels. It allows for importing run data, 
validating data quality, normalizing and exporting Olink data for subsequent statistical analysis.

1.2 Intended target group
Olink NPX Signature is intended for research use only. Not for use in diagnostic procedures. All trademarks and copyrights 
contained in this material are the property of Olink Proteomics AB unless otherwise stated. For questions, guidance, and 
support, including questions regarding Olink Focus panels, contact Olink Support at support@olink.com. Olink NPX 
Signature is intended to be used by trained users of the Olink Target analysis platform

2. List of abbreviations
%CV Coefficient of Variation

IFC Integrated Fluidic Circuit (also called "chip" in this document)

LLOQ Lower Limit of Quantification

LOD Limit of Detection

LOQ Limit of Quantification

LQL Lowest Quantifiable Level

PCR Polymerase Chain Reaction 

QC Quality Control

ULOQ Upper Limit of Quantification

3. Safety
This chapter contains important safety information. 

3.1 Definition of alert levels
The following alert levels are used in the Olink Explore manuals:

IMPORTANT:  Indicates an important action that may impair the results if not performed correctly.                                 

NOTE:  Contains information that can make it easier to understand or perform a certain task. 

Part 1: Introduction 
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4. Associated documentation
• Olink® Signature Q100 User manual, doc no 1172

• Olink® Target 48 User Manual, doc no 1141

All relevant Olink documentation is available from the Olink website  https://www.olink.com/downloads

5. Technical support
For questions, guidance and support, contact Olink Proteomics at support@olink.com.

6. Process
Olink NPX Signature is a standalone Windows software application that lets you import data from Olink® Signature Q100, 
validate its quality and normalize it. The data is not required to be annotated or processed before importing it into Olink 
NPX Signature. The software can also process Fludigim® Biomark™ data obtained by running Olink kits.

 
 

 
 

Olink® NPX Signature

Olink® 
Signature Q100 QC Evaluation Export Data 

Save  
Analysis Report 

Import 
Run Data

 

Annotate 
Plates
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7. Software and file requirements
Components Minimum Recommended

Operating System Windows® 10 or higher

Processor Intel® Core™ i5 Intel® Core™ i7 or higher

Memory 8 GB RAM 16 GB RAM or more

Disk Space 500 MB 500 MB

7.1 Files and information
Olink® NPX Signature Study File (.npx)

IMPORTANT:  To enable Olink NPX Signature's remote data functions to Olink Signature Q100, ensure that the 
instrument is connected to the network and TCP port 8085 (enabled by default) is not blocked. For instructions 
on how to securely connect the Olink Signature Q100 to a network, refer to the Olink Signature Q100 User 
manual.

Olink NPX Signature stores all study data in a file with the extension .npx. This file is the single repository for all study-
related data required by Olink NPX Signature to display, review, and export data for a study. 

Place this NPX file on your local computer or in a folder on the network. NPX files are typical ~5–10 MB in size but can be 
larger if you save the run data in the .npx file.

7.2 Files and Information Needed for Analysis
Q100 Run Data

This is the Olink Signature Q100 run data that can be imported into Olink NPX Signature without the need for annotation 
or processing in advance. The file types and information accessible for analysis are:

• Olink Signature Q100 export file (.q100 or .zip);

• Olink NPX Manager project file (.oaf); or

• Fluidigm Real-time PCR exported heatmap or table file (.csv).

See the tutorials and the help sections in Olink NPX Signature for more information.

Plate Manifest File
Microsoft Excel file (.xlsx) that can be used to define the sample plate layout.

Panel Data File

File needed to properly process and quality control your data. This file is unique to your panel and kit lot. The file is 
provided by Olink.

NOTE:  The size of the .zip file that is transferred via USB from Olink Signature Q100 might be larger than  
20 MB. An NPX Signature study that includes run data in the .npx archive might be too large to email to Olink 
Support. If possible, email only the Olink NPX Signature file with the .npx extension.

Part 1: Introduction 
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8. Installing

8.1 License agreement
You are required to accept the end-user license agreement when installing Olink NPX Signature or before using an 
updated version for the first time.

8.2 Install software
The installer performs a first-time installation or an update to the current installation if it is already installed on your local 
computer. Any updates to the software retain all existing user settings and custom data.

1. Download the latest version of the Olink NPX Signature software to your computer from olink.com/software.

2. Open the zip folder.

3. Double-click the installer (.msi) file.

4. Follow the on-screen instructions.

5. Olink NPX Signature will be displayed in the Windows Start menu for future use. To open the application, double-click 
on the icon. 

IMPORTANT:  Before using Olink NPX Signature for the first time or upon installation of an updated version, you 
are required to accept the end-user license agreement.

8.3 Uninstall software
If you need to uninstall Olink NPX Signature, it can be uninstalled using the Windows Add found in Windows Settings, or 
Remove Programs in the Control panel. Select Olink NPX Signature from the program list and click Uninstall.

All user data is retained where it was saved before the application was uninstalled, and your custom Olink NPX Signature 
settings are retained on the system.

Part 1: Introduction 
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Part 2: User Interface

9. General

9.1 Start view
1 2

No Function Description

1 Main menu Access main functions.
Click on the three lines in the top left corner to expand the 
main menu. 

2 Recent studies Show recent opened studies.
Click on a project to get to the Study Overview.

Part 2: User Interface 
9. General
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9.2 Main menu

Function Description

Home Access the main level of the application, where you see your 
most recently opened studies.

Learn  Access all the integrated tutorials. Refer to 11. Tutorials and 
in-line help for more information.

Create Study Create a new study.

Open Study Open an existing study.

The expanded menu lists three functions in the lower part of the menu.

9.2.1 Lower part of main menu

Function Description

Instruments Show a list of Olink Signature Q100 instruments available to 
the Olink NPX Signature software over the network.

Settings Access the application settings. Refer to 10. Settings for more 
information.

About For instructions on how to securely connect the Olink 
Signature Q100 to a network, refer to the Olink® Signature 
Q100 User Manual.

Part 2: User Interface 
9. General



10

10. Settings
Click Settings on the main menu to customize the view.

General

• Change the color theme of the application and charts.

• Enable or disable the advanced user features. 

• Customize the Analysis Report by adding a company name and logo.

Layout Templates 

Review or create new sample plate layouts to define the sample types for each well.

Panels

• Review all Panel Data Files in the application.

• Import or remove Olink Flex Panel Data Files.

11. Tutorials and in-line help
Olink NPX Signature contains integrated tutorials and in-line help. 

11.1 Tutorials
Click Learn on the main menu to access integrated tutorials meant to assist you in learning the various features of Olink 
NPX Signature. Click a tutorial and navigate through the pages using Next or Previous.

You can also launch a tutorial by clicking
 

in the end of the in-line help content.

11.2 In-Line help
Click the  icon in the upper-right corner of a view to access the in-line help, which contains information about the 
usage of the current view. If the contextual help is longer than the allowed space, a scroll bar appears that lets you read 
the full text.

Part 2: User Interface 
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Part 3: Operation

12. Introduction
Input data for Olink NPX Signature are run files from Olink Signature Q100, Ct values exported from the Fluidigm Real-
Time PCR Analysis software, NPX Manager .oaf project files and NPX Signature .npx study files. After quality control and 
normalization against the Extension Control, the IPC, and a bridging factor, the output data are obtained in NPX values. 

For Olink Target 48, normalization against the Extension Control, Calibrator, and bridging factor is performed. The default 
output data is in standard concentration units (pg/mL).

This section describes how you analyze data step-by-step in Olink NPX Signature. Olink Target 48-specific information is 
highlighted. The following steps are included in the standard operating procedure:

1. Create an Olink Target 48 Study.

2. Import run data.

3. Verify panel and plate layout information.

4. Under Details, enter optional study information.

5. Perform quality controls including additional quality assessment.

6. Export Data and Analysis Report under Export tab.

 

Part 3. Operation 
12. Introduction
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13. Start a project

13.1 Import panel data files
Every panel has its own panel data file, which is provided by Olink. These panel data files are included in the software. To 
ensure that you have the panel data files corresponding to the Target 48 kit you have run, make sure to always use the 
latest version of Olink NPX Signature.

13.2 Create a study
To create a study, perform the following steps:

1. Click Create a study.

2. Select Product.

3. Enter Study Name (required information), Sample Type and Notes.

4. Click Create. 

13.3 Import run data
Add run data to a new study
When prompted, select your Run Data Source:

• To import run data directly from an Olink Signature Q100 instrument, select Olink Q100 Connect. Select the desired 
run(s) and press Next. 

NOTE:  Run data cannot be saved in the npx folder. Please make sure that the data is securly saved on disk/
server/computer.

 – Select Next again and verify panel, data file version and plate layout information. Click Add. The Study Overview 
will appear.

• To import run data files from your computer or a local server, select Run Data Files. 

 – Select the desired run data file(s). Valid options are Olink Signature Q100 export files, .q100 or .zip, exported 
heatmap or table results files in .csv format from Fluidigm Real-time PCR analysis software.

 – To add more run data files, simply click on Add again and select the next file. Please note that more run data files 
can be added to the project at later stages as well.

 – If the wrong file is included, mark the file and click Remove.

NOTE:  A study cannot include different panel types at the same time. It can consist of only runs from one of the 
following panels: Olink Target 48, Olink Target 96, Olink Focus, or from Olink Flex.

If duplicate sample names are found, Olink NPX Signature prompts an alert message box. During data handling, unique 
sample and assay names are necessary for proper handling of the data. Change sample names if needed. Sample names 
can be changed directly in Olink NPX Signature by importing a sample manifest in the Plate Manifests view. Refer to the 
built-in help for more information.

When the selected runs have been validated, click Next. Select the correct Panel and Panel Data File for each of the 
imported runs, and select if the plate should have the default plate layout or if the layout should be mapped based on a 
plate manifest. Click Add.

For instructions on how to securely connect the Olink Signature Q100 to a network, please refer to the Olink® Signature 

Q100 User Manual. 

Part 3. Operation 
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Add run data to existing study
Open your already saved study. Expand the main menu by clicking the three horizontal lines in the top left corner. Select 
Import Run Data, and follow the above instructions to add data directly from an Olink Signature Q100 instrument or from 
run data files on your computer.

13.4 Enter study information
Study information can be entered in the Study -> Details view 

• Enter information in some or all the following fields to be displayed in the Analysis Report:

 – Sample Type

 – Customer Info

 – Business Development Manager

 – Lab Info

 – Report Notes

 – QC Notes for Analysis Report

13.5 Verify plate layout and sample annotation
1. Select Plate QC → Plate Layout to display the imported runs for each Olink panel and plate.

2. Under Plate Details, verify that the correct panel data file version is selected in the drop-down menu. The same data file 
version will be used for all runs of the same Olink panel in the study.

3. Verify that the plate layout is correct. To change the plate layout, select one or several wells and right- click to change the 
well type. 

Available types are:

• Sample (S)

• Negative Control (NEG)

• Sample Control (SC)

• Calibrator (CAL)

• N/A

Calibrator, Negative Control, and Sample Control must be annotated for calibration normalization and QC to be 
performed. 

4. Repeat steps 2 and 3 for all imported plates before continuing.

Part 3. Operation 
13. Start a project
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14. Perform quality controls
1. Perform the QC for each plate separately using the Sample QC tab.

2. Perform quality assessment for all plates using the other views and then make an overall assessment.

The acceptance criteria for passing QC are described below.

Criteria Recommended value Note in results file

Run QC

Controls Std. Dev. of Incubation Control < 0.5 NPX 

Samples Std. Dev. of Incubation Control < 0.2 NPX

Controls Std. Dev. of Detection Control < 0.5 NPX 

Samples Std. Dev. of Detection Control < 0.2 NPX

Number of flagged samples ≤ 1/6 of total number of samples on plate (8 
samples on a full plate)

Number of failed assays ≤ 3 out of 45

Calibrator or Control replicates outside LOQ ≤ 1/3 of the Sample Control- or Calibrator 
replicates are outside of LOQ for < 5 assays

Number of flagged Sample Controls ≤ 1

Number of flagged Calibrators ≤ 1

Sample QC

Incubation Control deviation < ±0.3 NPX from plate median of samples

Detection Control deviation < ±0.3 NPX from plate median of samples

Assay QC

Accuracy Sample Control ±30% of the expected concentration Warning

Precision Sample Control Intra-CV <30% Warning

Control replicates outside LOQ ≤ 1/3 of the Sample Control replicates are 
outside of LOQ

Warning

Calibrator replicates outside LOQ ≤ 1/3 of the Calibrator replicates are outside 
of LOQ

Fail  
(results are 
replaced by "No 
Data")

Precision Calibrator Intra-CV <30% Warning

TIP:   If Std. Dev. is higher than the recommended value for internal controls, evaluate the Control signal 
deviation from median/sample QC graph to identify any extreme outlier samples. Exclude these samples  from 
the QC analysis (click on the sample in the graph and select QC analysis: Excluded) and re-evaluate the run QC 
again.

Part 3. Operation 
14. Perform quality controls
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14.1 Perform a quality assessment
Parameters that need to be evaluated for each run are listed in the table below. The corresponding information in NPX 
Signature can be found in the lower left corner under Plate Metrics.

If all plates pass quality control and assessment, the quality control is finished, and the data is ready for export and 
reporting.

Information Recommended value Comment

Plate ANOVA ≤ 10 (number of assays) No warning.

> 10 (number of assays) May be caused by insufficient randomization 
or other issues. If samples were not randomized, 
this warning can be disregarded.

NOTE:  These guidelines are based on a 
two-plate study. The larger a study is, 
the smaller the detectable differences 
become.

Row/Column 
ANOVA

< 7 (number of assays) No warning.

7–14 (number of assays) Possible randomization issue. Refer to section 21.

14–21 (number of 
assays)

Re-run plate or verify that this is not the result of 
a poorly  executed run.

For high values, investigate the Assay QC view.

%CV Intra < 15% Refer to Section 19.

%CV Inter < 25%, maximum 40% Refer to section 19.

Detectability > 75% of the samples The detectability should be comparable across 
plates if the samples run are randomized.

14.2 Additional quality assessment
NOTE:  Switch between Ct, NPX and Quantified values in each view e.g. to evaluate the effect of normalization or 
to search for position effects in internal controls and assays.

To perform additional quality assessment, follow these steps: 

1. On the Assay QC tab, view the values of internal controls and assays (change assay in the drop-down menu above the 
plate layout) for each sample. For example, search for specific patterns that may indicate technical errors.

2. On the Table tab, evaluate patterns of data below LOD between sample plates in a study and/or remove specific assays 
or single datapoints from a study/sample plate.

3. On the Heatmap tab, search for outlier samples and/or visualize homogeneity of the control replicates (change sample 
type in the drop-down menu).

4. On the Detectability tab, evaluate the detection limit for each assay and sample plate. For the Olink Target 48 panels, 
some assays can be expected to have LOD values above 2.5 NPX and this should not affect the number of samples that 
can be quantified above the plate LOD. The Detectability view can be used to assess if such assays have a high number 
of samples outside LOQ.

5. The Z-scores tab displays differences in data distribution between sample plates as well as within plates.

Part 3. Operation 
14. Perform quality controls
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15. Export data
In the Export -> Data tab, Data can be exported for use in preferred applications. It can be exported both as CT, NPX, and  
pg/mL (default) in separate reports, by selecting the desired Data type. 

1. Under Panels, select from which panels in the study data should be exported. 

2. To export data according to the recommended default settings, click Defaults.

NOTE:  The settings in the Export Data view may be adjusted to change the format, layout, or to add additional 
data to the export. Refer to the table below for more information.

3. When the desired options have been selected, click Generate.

4. Enter a filename and location in the Save dialog, select an export format and click the Save button.

Setting Description

Data Options: QC data Deviation from plate median for Incubation Control and Detection Control is 
exported in NPX values for each sample.
Data for the controls cannot be calculated in pg/mL and will be exported in 
NPX in the results file for quantified values.

Data Options: Plate LOD Will export plate LOD for each plate.

Output format Wide format or Long format. Wide is the default matrix format and Long 
format will output one line per datapoint.

NOTE:  In Excel, there is a number of rows limit of 1 048 576. If this  
number is exceeded, Excel export will not work. Select Text format 
instead.

File Type Microsoft Excel (.xlsx) or Text (.csv)
For CSV format, column separator and decimal separator can be configured

Sample types: Samples Export data for customer samples.

Sample types: Sample 
Control

Export results from the Sample Controls.

Sample types: Plate 
Controls

Export results from Negative Control and Calibrators.

Assay types: Assay Export results for assays.

Assay types: Control Assay Export results for internal control assays. 
Data for internal controls cannot be calculated in pg/mL and will be blank if 
quantified values are selected for export.

Part 3. Operation 
15. Export data
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15.1 Considerations
Solor indications noted below are valid for Microsoft Excel exports only.

• Data from assays and samples that have not passed the sample QC are reported in red text and are marked with 
Warning.

• Samples, assays, or data points that have been marked as failed in the software are reported as No Data.

For panels with absolute quantification, the data are given in standard units (pg/mL) and presented as follows:

• Data between LQL and ULOQ is reported as pg/mL value in white cells.

NOTE:  Lowest Quantifiable Level (LQL) is defined as the value used as the lower limit, LLOQ (default) or plate 
LOD (when plate LOD > LLOQ)

• Data > ULOQ is indicated as > ULOQ in red cells.

• Data below LQL but above the lowest fitting parameter in the 4PL curve fit model, is presented in pg/mL value in red 
cells.

• Data below lowest fitting parameter in the 4PL curve fit model cannot be calculated and is indicated as NaN in red 
cells.

• Failed data points (either because of assay failure, sample failure or chip failure) are indicated as No data in grey cells.

• For samples and assays with QC warning, values are indicated as described above but marked in red text. Data from 
samples and assays that do not pass QC should be treated with caution.

• For each plate and assay, values for LQL, LOD, LLOQ and ULOQ, as well as results for assay QC in Assay warning are 
presented on separate rows below the data for the samples.

• Missing data frequency is reported for each assay and indicates the percentage of samples with values < LQL, > ULOQ 
as well as failed data.

Result and QC results In Data report

Sample 
QC

Calibrator 
QC 
precision

Sample 
Control QC 
precision 
and/or 
accuracy

Sample 
Control 
replicates 
within LOQ

Calibrator 
replicates 
within LOQ

Data 
between LQL 
and ULOQ

Data 
Output 
Format

Sample 
QC

Assay 
QC

Notes

Pass Pass Pass Pass Pass Yes pg/mL Pass Pass

Fail Pass Pass Pass Pass Yes pg/mL Warning Pass Treat with 
caution

Pass Fail Pass Pass Pass Yes pg/mL Pass Warning Treat with 
caution

Pass Pass Fail Pass Pass Yes pg/mL Pass Warning Treat with 
caution

Pass Pass Pass Fail Pass Yes pg/mL Pass Warning Treat with 
caution

Pass Pass Pass Pass Fail – No Data Pass Fail Data is 
unreliable 
and not 
shown

Pass Pass Pass Pass Pass No; < curve 
fitting

NaN Pass Pass

Pass Pass Pass Pass Pass No; > curve 
fit, but < LQL

pg/mL Pass Pass Treat with 
caution

Pass Pass Pass Pass Pass No;  > ULOQ >ULOQ Pass Pass

Part 3. Operation 
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The NPX results can be exported as an XLSX file. The NPX data are presented as follows:

• As NPX values.

• Values below LQL have a red cell background.

• Data for samples with a QC warning are indicated in red text. Data from samples that do not pass QC should be treated 
with caution.

• The LOD value for each assay is presented on a separate row below the data for the  samples and is indicated as LOD.

• Missing data frequency is presented for each assay and indicates the percentage of samples with values  below 
Maximum plate LOD.

The layout is described in the table below for wide format and for long format in the table after.

Study Name Olink NPX 
Signature 
version

NPX data or 
Quantifed data

Panel Panel 1 … Panel x Panel 1 … Panel x Panel 1 … Panel x

Assay 1 2 3 … 96 1 2 3 … 96 Plate ID Plate ID QC
Warning

QC
Warning

Uniprot ID 1 2 3 … 96 1 2 3 … 96

Olink ID 1 2 3 … 96 1 2 3 … 96

Sample #1 1 2 3 … 96 1 2 3 … 96 plate_1. 
csv

plate_x. 
csv

Pass / 
Warning

Pass / 
Warning

Sample #2 1 2 3 … 96 1 2 3 … 96 plate_1. 
csv

plate_x. 
csv

Pass / 
Warning

Pass / 
Warning

Sample #x 1 2 3 … 96 1 2 3 … 96 plate_1. 
csv

… plate_x. 
csv

Pass / 
Warning

Pass / 
Warning

…

[Assay warning] 1 2 3 … 96 1 2 3 … 96 plate_1. 
csv

plate_1. 
csv

[Lowest 
quantifiable level]

1 2 3 … 96 1 2 3 … 96 plate_1. 
csv

plate_1. 
csv

LOD 1 2 3 … 96 1 2 3 … 96 [plate_1. 
csv]

[plate_1. 
csv]

[ULOQ] 1 2 3 … 96 1 2 3 … 96

[LLOQ] 1 2 3 … 96 1 2 3 … 96

Missing Data freq. 
(%)

1 2 3 … 96 1 2 3 … 96

Normalization type 1 2 3 … 96 1 2 3 … 96

Part 3. Operation 
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Column Description Type

SampleID The annotated sample ID String

Index Well index in 96 plate Integer

OlinkID OlinkID for assay String

UniProt UniProt ID for assay String

Assay Gene name for assay String

MissingFreq. Frequency of missing data (below LOD or NaN) Float

Panel Panel name assay belongs to String

Panel_Lot_Nr Lot number for the panel Integer

PlateID Name of the plate the sample was run on String

QC_Warning Indicates whether the sample passed QC or not String PASS, WARN or FAIL

LOD LOD value for assay Float

NPX NPX value Float

Normalization Type of normalization used in study String Plate control or Intensity

Assay_Warning Indicates whether the assay passed QC or not String PASS or WARN

15.2 Create an Analysis Report
Once all data has been thoroughly checked, Olink NPX Signature can generate an Analysis Report for the study. The 
Analysis Report includes information and QC parameters for the study.

Go to Export -> Report and select all panels to be included in the Analysis Report. Click Create to save the Analysis Report 
as a PDF document. A preview of the document will appear.

Part 3. Operation 
15. Export data
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Part 4: Quality control

16. Overview
Olink has built-in quality controls in all multiplex panels. Each 48-plex panel contains 45 assays. Three of these are internal 
controls that allow for an in-process quality control designed to monitor different steps of the protocol: immuno reaction, 
extension and amplification/detection. 

Immuno reaction Extension and 
pre-amplification

Amplification and
detection

• The Incubation Control consist of non-human antigen measured with PEA assays. This control monitors potential 
variation in all three steps of the reaction.

• The Extension Control is an antibody coupled to both DNA-tags (hence always in proximity). This control monitors the 
extension/pre-amplification and amplification/detection step and is used for normalization of the data.

• The Detection Control is a complete double stranded DNA amplicon which does not require any proximity binding or 
extension step. This control monitors the amplification/detection step.

The internal controls are used for both sample and run QC as described below. The quality control of data is performed 
separately for each sample plate.

16.1 Sample QC
Each of the internal controls are spiked into all samples at a set concentration. The signals for these are therefore expected 
to be the same over the entire plate. Sample QC is performed using the Detection Control and Incubation Control. 
Within each run, the levels of these controls are monitored for each sample and compared against the plate median of 
all samples. If either of the controls deviate more than the acceptance criteria allow (see below), the sample gets a QC 
Warning and the sample is flagged in Olink NPX Signature. The Extension Control is used in the normalization step and in 
generation of NPX, and hence is not included in the quality control of data.

Acceptance criteria for passing a sample:

• Incubation Control and Detection Control deviates < ±0.3 NPX from the median of the samples on the plate for the 
corresponding internal control. 

Deviating values for the internal controls can be caused by, for example, errors in pipetting or pre-analytical factors in the 
samples that affect the performance of the assay. For more information on troubleshooting samples that do not pass QC. 
Refer to 19. Deviating controls for more information.

For reference values for passing Sample QC, refer to 14. Perform quality controls.
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16.2 Run QC
The internal controls are also used in the run QC. This QC assesses the variation over the plate for each of the Incubation 
Controls and the Detection Control. If the variation for one of the controls is too large (see below) the entire run is 
considered unreliable.

For acceptance criteria for passing a run, refer to 14. Perform quality controls..

If a too large variation is observed for either of the controls, go to the Plate QC -> Assay QC and/or Sample QC tab to 
evaluate the data. For example, if individual samples show extreme values or if a certain sample column is affected, these 
samples can be marked as failed, and the QC redone and re-evaluated. For more information on troubleshooting of this 
step, refer to 19. Deviating controls.

In addition to passing or failing individual plates, ensure that no systematic bias is present in the data. The Plate metrics 
view in the bottom left corner alerts you to such issues.

%CV is calculated using the Sample Control present in triplicates on each sample plate. The reported %CV is the mean 
%CV over all assays, and this is only calculated using data in pg/mL from non-flagged replicates within LOQ. A high %CV 
does not fail a run automatically but should be a cause for further investigation.

For reference values for %CV, refer to 14. Perform quality controls..

16.3 Assay QC
Quality control of assays is performed for Olink Target 48. An expected concentration value for the Sample Control for 
each assay is defined during the validation of the panels. The accuracy and precision for the calculated concentration 
values of the Sample Control replicates as well as the precision of the Calibrator replicates are evaluated for each assay.

Acceptance criteria for passing an assay:

• The accuracy of the calculated concentration mean for the Sample Control for each assay must fall within ±30% of the 
expected concentration. If this criterion is not met, the assay is noted with “Warning” in the results file.

• The precision of the calculated concentration for the Sample Control Calibrator must be < 30%. If  the criterion is not 
met, the assay is noted with “Warning” in the results file.

• A maximum of one of the Calibrator replicates can fall outside of the limits of quantification (LOQ). If the criterion is 
not met, the assay is reported with “Fail” in the results file, and "No Data" will replace the results for the affected assay.

• A maximum of one of the Sample Control replicates can fall outside of the limits of quantification (LOQ). If the 
criterion is not met, the assay is noted with "Warning" in the results file.

For acceptance criteria for passing an assay, refer to 14. Perform quality controls..

Part 4: Quality control 
16. OVerview



22

17. Normalization methods
Olink has developed its own arbitrary, relative quantification unit called NPX™. In qPCR, the x-axis value of the point 
where the reaction curve intersects the threshold line is called the Cycle threshold (Ct). This indicates the number of cycles 
needed for the signal to surpass the fluorescent signal threshold line. NPX as well as the results available in standard 
concentration units are derived from the Ct values obtained from the qPCR using the steps below:

Extension Control:
CtAnalyte – CtExtension Control = dCtAnalyte

Inter-plate Control:
dCtAnalyte – dCtInter-plate Control = ddCtAnalyte

Adjustment against a correction factor:

Correction factor – ddCtAnalyte = NPXAnalyte

The correction factor is calculated by Olink during the validation of the panels.

17.1 Calibrator normalization
Calibrator normalization is used for Olink Target 48 panels. The calibrators are used to determine the protein 
concentration in the panel. The calibrators consists of a pooled plasma, with a spike-in of recombinant antigen for a select 
number of assays. Randomization of samples across and within plates is recommended but not mandatory.

For this panel, the Extension Control, the Calibrator and the bridging factor are used for the normalization calculation. The 
bridging factor is determined by Olink during the validation of the panels, and for each new kit lot, a lot-specific bridging 
factor is defined. NPX is derived from the Ct values obtained from the qPCR using the following equations for Olink Target 
48 panels:

Each sample is normalized with the Extension Control:
CtSample i, Assay j – CtSample i, Assay Ext ctrl = dCtSample i,Assay j

Each plate is normalized with its Calibrators to generate NPX levels and is adjusted against a pre- determined bridging 
factor.

Bridging factor Assay j – (dCtSample i, Assay j– Median(CalibratorSample i, Assay j)) = NPXSample i,Assay j

NOTE:  The NPX value will differ between the same protein measured on Olink Target 96 and Olink Target 48. 
This is mainly due to the fact that Olink Target 48 uses a bridging factor and Olink Target 96 a correction factor, 
and the sample used for plate normalization differs.

The NPX unit is unique to each protein assay, meaning that even if two different proteins have the same NPX values, their 
concentrations in pg/mL may differ.
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17.1.1 Results in standard unit (pg/mL)
The method for quantification of data in standard units (pg/mL) for Olink Target 48 is described in this section.

Method overview
The method requires fewer sample wells in each plate/run for controls compared to e.g. running a full calibration curve on 
each plate, allowing more wells to be used for customer samples.

Before the run (during product development at Olink):

1. A precise pre-defined standard curve is established for each protein.

2. A bridging factor, utlized to ensure accuracy between production batches, is calculated.

3. A four parameter logistic (4PL) model fit is performed to define the standard curve mathematically within the 
measurement range for each protein in the panel.

After each run:

1. The median value of the Calibrator triplicates is used to adjust the measured samples along the y-axis (NPX) to 
normalize between plates. In other words, the samples are normalized in the same way as the standard curve is during 
development. The samples are also adjusted against the bridging factor, see formula above.

2. The adjusted standard curve model, is used to convert the measured NPX value to the protein concentration in pg/mL.

Standard curve
During development, a thorough fine-tuned 32-point standard curve is developed for each protein biomarker 
simultaneously, including all 45 proteins. Multichannel pipetting and numerous replicates of the curves are used to 
minimize errors and establish an accurate immunoassay curve fitting. Due to the wide dynamic range of the PEA assays 
in the panel, a large spread of measurement points is required to cover the entire range. Eight measurement points, 
which are commonly used in many technologies, would not suffice for Olink’s multiplex measurement of 45 assays. The 
predefined standard curves avoid operator- dependent reconstitution and pipetting of standard curves at each lab and 
for each run. The figure below shows an example of a point standard curve defined for one assay during development.

Standard curves for each assay can be found via the panel product page (www.olink.com/t48cyt).

A 32-point standard curve defined for each assay during development.
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4PL model
A 4PL model curve fit is used to describe the immunoassay standard curve, indicated by the turquoise line in the 
figure below. When running a study, the measured sample value (represented by the dashed arrows) is related back 
to the adjusted standard curve model which translates the measured value to the protein concentration in pg/mL 
using the equation below. Where A = asymptote (a constant value) at low doses, B = slope factor, C = EC50 (mid-range 
concentration) and D = asymptote at high doses. These parameters are indicated in the formula below . An example of a 
point standard curve defined for each assay during development.

An example of a point standard curve defined for each assay during development.

Repeated testing and validation show that the 4PL curve fitting describes the standard curve well and can be used to 
correctly estimate the protein concentration in analyzed samples within the limits of quantification. The approximate lower 
and upper limits of quantification (ULOQ and LLOQ) are defined during the development of the panel, and specifications 
for LLOQ and ULOQ are established for each lot. This information is available in the individual Panel Validation Reports 
provided by Olink.
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Results reported in pg/mL
The figures and the list below provide an overview of how data in pg/mL is reported in the results file.

• Data between LQL and ULOQ is reported as a pg/mL value and shown in the white areas of the graphs.

NOTE:  Lowest Quantifiable Level (LQL) is defined as the value used as the lower limit, LLOQ (default) or plate 
LOD (when plate LOD > LLOQ).

• Data below the lowest fitting parameter in the 4PL curve fit model cannot be calculated and is indicated as NaN in the 
data export and in the red areas in the left side of the graphs.

• Data >ULOQ is indicated as >ULOQ in the data export and is found in the red areas to the right of the graphs. Values 
above ULOQ are not reported  in pg/mL due to high risk of misinterpretation of hooking data.

• Data below LQL is presented in pg/mL value s in the data export, and is shown in the red areas in the left side of the 
graphs. Values below LQL should be treated with caution due to decreased precision and accuracy in the lower range 
and should not be used for individual comparison to reference values.

For a more detailed list describing the results file, refer to 15. Export data.

Overview of how data in pg/mL is reported in the exported results file depending on if LLOQ>plate LOD (left) or if plate LOD>LLOQ (right). 
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Part 5: Troubleshooting

18. Introduction
This chapter describes issues that may arise during use of Olink NPX Signature, or data issues during analysis, and how to 
solve these issues. 

NOTE:  The figures in troubleshooting are schematic only and might not reflect the current interface of Olink 
NPX Signature for Olink Target 48.

18.1 Warning messages
The following warnings can be displayed:

1. Opening Study 

a. Could not identify the panel 

 – The panel datafile associated to plates in the study cannot be located and thus not identified.  Navigate 
to Settings -> Panels and import the required panel data file. 

2. Importing Run Data 

a. Quality Threshold does not meet specified criteria 0.5. 

 – The Quality Threshold defined for analysis was not set to 0.5.  Open Run data in Fluidigm Real-Time PCR and 
export the data after analyzing with a quality threshold of 0.5.

b. Baseline Correction method is not set to Linear. 

 – The Baseline Correction method defined for analysis was not set to Linear.  Open run data in Fluidigm Real-Time 
PCR and export the data after analyzing with a baseline correction method of Linear. 

c. Unsupported plate format 

 – The run data was not acquired with a supported IFC type.

d. Unsupported probe-type count, expected 1. 

 – The run data was not acquired with a supported protocol 

e. Panel types must match in study 

 – The study already contains a plate for one panel type (Olink Target 96, Olink Target 48, etc.).  All plates in the study 
must be run for the same panel type. 

f. Run barcode already exists in a study for the panel 

 – The run data for this IFC has already been imported to the study. 

g. Data integrity file not found in the archive 

 – The run data checksum file was not found in the Olink Q100 Signature export.  The run data must be analyzed and 
exported from Real-Time PCR before importing. 

h. Could not locate data file in file 

 – The run data analysis export was not located in the Olink Q100 Signature export file.  This may be due to a corner 
finding error during analysis, due to: 

 o Insufficient amount of ROX dye in corner wells

 o Contrast not optimal

 o Edge sample or assay is not loaded (e.g. air bubbles or particle clogging of the IFC)

Unzip the run data archive and open the ChipRun.bml in Fluidigm Real-Time PCR to analyze and export data. Manually 
set the corners using Fluidigm Real-Time PCR Analysis Software, export in CSV format and import in Olink NPX Signature.
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Make sure to zoom in to clearly see where the wells should be (if empty). All wells will not fit optimally, the important ones 
are the four corner wells.

i. Datafile checksum not verified 

 – The run data contained in the Olink Signature Q100 export file failed to validate using the checksum values 
generated when the analysis was performed.  This may indicate that the run data has been modified after it was 
initially analyzed when the run was going to be completed Unzip the run data archive and import the results_all.
csv, results_all.csvx, or results_heatmap.csv file directly. 

3. Importing Panel Datafiles 

a. Data file already exists 

 – A panel definition with the same name and version is already imported in the application. 

4. Importing Sample Manifest Files 

a. Unrecognized file extension for sample plate manifest 

 – The file format could not be processed.  Supported formats are Fluidigm Real-time PCR comma value separated 
plate definitions and NPX Signature XLSX format. 

b. No Sample-ID defined in input data 

 – The sample manifest import file does not define the Sample-ID column 

c. No Plate-ID defined in input data 

 – The sample manifest import file does not define the Plate-ID column 
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19. Deviating controls
If the normalized value for internal controls for a specific sample deviates from the rest of the sample set, the sample does 
not pass sample QC and is flagged in the software. A flagged sample should not be excluded from the data export but may 

be excluded from the QC analysis. Refer to 14. Perform quality controls for evaluation of the data.

Issue Explanation Reason Action

A sample is flagged.    A sample is flagged 
when one or several 
internal controls 
deviate from the 
plate median for that 
specific sample.

All flagged samples in a study are 
shown under Study -> Summary 
in the table Flagged or failed 
samples.

The behavior of the 
internal controls makes 
it possible to understand 
why the sample is flagged. 
See the rest of this section 
for more information. For 
more detailed information 
about flagged  samples, 
click the Plate QC -> 
Sample QC tab (Figure 
7) and the Assay QC tab 
(Figure 10).

Figure 1. The Sample QC tab, where the left circled sample is flagged by Incubation Control 2, and the right circled sample is flagged by the Detection 
Control. Both of these datapoints are outside the recommended threshod which is visualized with the blue dotted lines.
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Figure 2. Assay QC tab for samples shown in Figure 1. The circled sample to the left has a lower NPX for Incubation Control 2 (well C8). The circled 
sample to the right has a higher NPX for the Detection Control (well E10) and lower NPX for the Extension Control.

19.1 Sample flagged by Incubation Controls
Issue Explanation Reason Action

A sample is flagged by 
the Incubation Control.

The Incubation 
Controls deviate.

If the two Incubation Controls 
deviate, but not the Extension 
and Detection Controls, this is an 
indication that something (most 
likely in the sample) is affecting 
only the Incubation Controls.

See examples in 19.1.1.

19.1.1 Common reasons for deviating Incubation Controls.
Possible cause Explanation Solution

Sample matrix If the sample matrix for the flagged sample 
is different from the others on the same 
plate, the incubation environment can 
be different. This can make the reaction 
slightly more or less efficient.

Perform the QC 
evaluation for one sample 
type at a time.

Sample volume or concentration The sample volume is too high or too low. Set the sample as failed 
in the Plate Layout tab. If 
applicable, run the sample 
again and make sure the 
correct volume is used. 
See examples in Figure 1.

Sample quality If the sample is stored in a freezer for long 
periods of time, it can evaporate. A more 
concentrated sample can increase possible 
matrix effects, and thus make the internal 
controls more or less efficient.

Sample type Olink assays are validated for serum and 
plasma. Other sample matrices can contain 
factors that interfere with the immuno 
reaction step.

Standardize samples as 
much as possible (E.g.: for 
lysed cells and tissue, use 
similar concentration of 
protein in each sample).
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20. Sample flagged by Detection 
Control

Issue Explanation Reason Action

A sample is flagged by 
Detection Control.

The NPX value of the 
Detection Control for 
this specific sample 
deviates more than 
0.3 NPX from the 
plate median.

One example can be seen in 
Figure 1 and Figure 2. Data is 
normalized using the Extension 
Control. Since both Incubation 
Controls and the Extension 
Control display decreased 
Ct-values, the normalization 
step will adjust the data. The 
Detection Control that did 
not show decreased Ct-values 
will be overcompensated by 
normalization against the 
Extension Control and thereby 
deviate from the rest of the 
sample set after normalization.

This type of flag is 
generally caused by the 
same reasons as flagged 
Incubation Controls. It is 
not uncommon that both 
the Incubation Control 2 
and Detection Control flag 
simultaneously, but with 
opposite “direction” in the 
Sample QC. This is seen 
when the flagged sample 
affects both the extension 
and immunoassay step, 
but to different extent. See 
examples in 19.1.1.

20.1 Deviating external controls
Issue Explanation Reason Action

High Intra-CV 
value

Intra-CV value is larger 
than 15%.

The Sample Control replicates 
differ within the sample plate.

Check sample annotation 
of the Sample Controls 
and that they pass QC. 
Check the row pattern for 
rows A, B and C to make 
sure that none of the rows 
is an outlier (e.g. issue with 
a channel on one of the 
multichannel pipettes). 
If one Sample Control 
replicate deviates from 
the other two and this 
pattern can be confirmed 
for several assays, this 
could indicate
a manual issue with this 
replicate. In such case, 
that replicate can be 
failed and the remaining 
replicates used for CV 
calculation. Please contact 
support@olink.com for 
further guidance.
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High Inter-CV 
value

Inter-CV value is larger 
than 25%.

The Sample Control replicates 
differ between sample plates.

Check sample annotation 
of the control samples and 
that they pass QC. If one 
Sample Control replicate 
deviates from the other 
two and this pattern can 
be confirmed for several 
assays, this could indicate
a manual issue with this 
replicate. In such case that 
replicate can be failed 
and the remaining used 
for CV calculation. Please 
support@olink.com for 
further guidance.

Issue Explanation Reason Action

High LODs that affect 
the number of samples 
that can be quantified 
above LOD.

Calculated LODs 
are out of expected 
range.

• Wrong datafile.

• Wrong panel.

• Contamination of Negative 

Controls.

• Wrong annotation of Negative 

Controls, Sample Controls or 

Calibrators.

• Confirm annotation of 

Negative Controls, Sample 

Controls and Calibrators.

• Confirm datafile; reanalyze 

data.

• Please contact support@

olink.com for further 

guidance. 

Sample Control intra CV 
> 30% and/or accuracy 
> ±30% causing many 
failed assays.

Sample Control intra 
CV > 30% and/or 
accuracy  
> ±30%.

Sample Control replicates differ 
within the same plate.

Check sample annotation 
of the Sample Controls 
and that they pass QC. 
Check the row pattern for 
rows A, B and C to make 
sure that none of the rows 
is an outlier (e.g. issue with 
a channel on one of the 
multichannel pipettes). 
If one Sample Control 
replicate deviates from the 
other two and this pattern 
can be confirmed for 
several assays, this could 
indicate a manual issue 
with this replicate. In such 
case that replicate can be 
failed and the remaining 
used for CV and accuracy 
calculation. Please contact 
support@olink.com for 
further guidance.
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Calibrator  
intra CV > 30% resulting 
in many assays with 
warning.

Calibrator  
CV > 30%.

Calibrator replicates differ within 
the same plate.

Check sample annotation 
of the Calibrators and 
that they pass QC. Check 
the row pattern for rows 
F, G and H to make sure 
that none of the rows is 
an outlier (e.g. issue with 
a channel on one of the 
multichannel pipettes). If 
one Calibrator replicate 
deviates from the  other 
two and this pattern can 
be confirmed for several 
assays, this could indicate 
a manual issue with this 
replicate. In such case that 
replicate can be failed and 
the remaining used for CV 
calculation. Please contact 
support@olink.com for 
further guidance.

20.1.1 Missing sample data
Issue Explanation Reason Action

Missing sample data in 
exported results file.

Data for some 
samples are not 
exported.

This can be caused by not using 
unique sample names.

Ensure that sample names 
are unique by checking 
Plate QC -> Samples tab 
or change sample type to 
Control for non- unique 
samples to force export of 
data for these samples.
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21. Inconsistent results detected
21.1.1 Variation between plates - common reasons

Issue Explanation Reason Action

The “Plate ANOVA” value 
in the Panel metrics  box 
(Figure 3) shows a high 
value. The variation is 
also shown on the Plate 
QC -> Z-scores tab 
(Figure 4. Plate variation 
that should
be solved by intensity 
normalization.).

The total NPX varies 
between plates.

May be caused by insufficient 
randomization, meaning that 
the distribution of samples from 
different groups is not the same 
for all plates in the study.

If the samples are 
completely randomized, 
make sure that intensity 
normalization has been 
used. The results will then 
look like the example 
in Figure 5, the same 
results as in Figure 4 after 
intensity normalization.

High Inter-CV value Inter-CV value is 
larger than 25%.

The Sample Control differ 
between sample plates.

Check sample annotation 
of the Sample Controls 
and that they pass QC. If 
intensity normalization
has been used, ensure 
that randomization 
assumption is valid by 
comparing with IPC 
normalization.

Figure 3. The Panel metrics field, with a Plate  
ANOVA value that indicates variation between plates.
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Figure 4. Plate variation that should be solved by intensity normalization.

Figure 5. The same results as in Figure 4, after intensity normalization.
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21.1.2 Variation within a plate - common reasons
Issue Explanation Reason Action

The columns or row 
ANOVA in the Plate 
Metrics or Panel 
Metrics box show high 
values. The effects are 
visualized in the Assay 
QC tab.

Areas of a plate 
(rows and/or 
columns) have 
systematically higher 
or lower values (Ct 
and/or NPX) than 
the rest of the plate.

The variation is caused by the 
sample position on the plate. 
Within-plate effects are often 
caused by laboratory mistakes.

See examples in  the next 
table.

Position effects/patterns: visible only for Internal controls

All internal controls are 
affected on Ct-level in 
a similar manner (all 
increased or decreased.)

One sample column 
or row consistently 
show deviating 
values.

Pipetting error, e.g. pipette not 
pre- conditioned.

Exclude data from 
analysis and/or rerun.

Mistake during pipetting of the 
incubation solution, extension 
solution, detection solution or 
samples.

Refer to Figure 6.

Evaporation due to incomplete 
sealing of plate during incubation 
or PCR steps.

Exclude data from 
analysis and/or rerun.

Different sample matrices. QC matrices separately.

Incubation Controls and 
Extension Control differ 
from Detection Control 
on Ct-level.

Incubation and 
Extension Controls 
show the same 
pattern, Detection 
Control shows 
another pattern.

PCR instrument not good at 
keeping 50°C, Detection Control 
not affected by extension step.

Rerun from immuno 
reaction step.

May be pre-analytical (interfering 
factors may affect all controls but 
the Detection Control).

Contact support@olink.
com for further guidance.

Incubation Control(s) 
differ from Extension 
and Detection Controls.

One or both 
Incubation Controls 
show deviating 
pattern.

Pre-analytical factors in samples 
that interfere with the immuno 
reaction.

Few deviating samples: 
Exclude samples from 
subsequent statistical 
data analysis.
> 1/6th of samples 
deviating: Contact 
support@olink.com for 
further guidance.

Position effects/patterns: visible for samples and Internal controls

Columns/rows/parts of 
sample plate.

Patterning that 
follows sample 
naming/sample 
matrices.

Different sample matrices. QC matrices separately.

Gradient over the 
sample plate.

Upper or lower part 
or left and right 
part of the plate 
affected with clearly 
deviating values.

IFC issue.
Poor vortexing in extension step.
Poor mixing of detection mix.
Uneven temperature in PCR 
block.

Rerun.
Contact support@olink.
com for further guidance.

NOTE:  Make sure 
that the deviation 
cannot be explained 
with biological 
variation, i.e. that 
a unique sample 
group is placed on 
one column/row.
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Common problems and reasons for within-plate effects.

Problem Possible cause Figure reference

First column different than the rest of the plate 
(observed for internal controls).

The pipette was not 
preconditioned.

A specific column or columns is/are different 
than for the rest of the plate (observed for 
internal controls).

A mistake when the incubation 
solution, extension solution, 
detection solution or samples 
were pipetted.

Figure 7.

One row consistently different from the rest of 
the plate (observed for internal controls and/or 
samples).

The pipette tip in that specific 
position was not tight enough.

A gradient from row A to row H. Pipetting was done at an angle.
The plates were not sufficiently 
vortexed.

Figure 10.

Deviating Z-score distribution for single assays 
on one plate.

Primer contamination. Figure 9.

21.1.3 Extreme outliers - common reasons
Issue Explanation Reason Action

Extreme blue or red lines 
in heatmap (when only 
selecting “samples” in the 
drop-down menu)
or outlier dots in z-score 
view.

Sample with 
extremely low 
or high protein 
quantification.

Incorrect dilution of sample No 
sample added.

Fail sample.

NOTE:  Extreme outliers 
can be discovered in 
different views (Plate 
QC -> Z-scores, Assay 
QC, Heatmap). In Figure 
6, two types of outliers 
are illustrated.
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Figure 6. Heatmap with display type Delta with NPX values from a single plate run which contains two outliers. Sample 25 has the lowest  
NPX values for all assays and Sample 71 has the highest NPX values for all assays.
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For Sample 25 in Figure 6, most NPX values are below LOD and one conclusion for this outlier is that there is no biological 
sample present in that well.

For Sample 71 in Figure 6, the NPX values are higher than for the rest of the samples. This can e.g. arise from poor dilution 
of a sample.

Figure 7. Ct-values that show results of laboratory mistakes. Refer to table below for a description of errors performed on this run.

Figure 8. NPX values that show results of laboratory mistakes. Refer to table below for description of errors performed on this run.

Explanation of columns in Figure 7 and Figure 8. Red numbers indicate laboratory mistakes.

Column 4
(correct)

Column 7 Column 8 Column 9 Column 10 Column 11 Column 12

Incubation mix (µL) 3 3 3 3 3 6 3

Sample volume (µL) 1 1 1 0 2 1 1

Extension mix (µL) 96 96 192 96 96 96 96

Detection mix (µL) 7.2 14.4 7.2 7.2 7.2 7.2 7.2

PCR product (µL) 2.8 2.8 2.8 2.8 2.8 2.8 5.6
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Figure 9. Ct values that show primer contamination of Incubation Control 2.

Figure 10. Within plate effects due to incorrect or insufficient vortexing of the sample plate during sample dilution.

21.1.4 High NPX signals - common reasons
Issue Explanation Reason Action

Unexpectedly high 
NPX signals in diluted 
panel for the majority of 
samples.

Low variation 
between samples
Saturated assays 
(may be visualized in 
Z-scores tab).

Samples were not diluted. Rerun from sample 
dilution step.
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22. Revision history
Version Date Description

1.11 2023-11-21 6, flowchart updated.

13.3, Note added.

Updated version number to match software version  
(version 1.2÷1.10 does not exist).

Screenshots updated.

Editorial changes.

1.1 2023-03-16 New trademarks and disclaimer. 

Clarifications regarding how data is reported.

15.1: tables updated.

Editorial changes

1.0 2023-02-15 New
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